LED Display Configuration Software SmartLCT

User’s Manual

Software Version: V3.0
Welcome to use the product from Xi’an NovaStar Tech Co., Ltd. (hereinafter referred to as “NovaStar”). It is our great pleasure to offer this manual to help you understand and use the product. We have striven for precision and reliability during the compilation of this manual, and the content of this manual is subject to change without notice. If you have any problem in use or you have any suggestion, please feel free to contact us according to the contact information provided in this manual. We will do our utmost to satisfy your needs. We would like to express our sincere thanks to your suggestions and make assessment for adoption as soon as possible.

Copyright © 2017 NovaStar

No part of this document may be copied, reproduced or extracted in any form or by any means without the prior written consent of NovaStar. All rights reserved.

Trademarks

and are registered trademarks owned by NovaStar.

All other trademarks, brand, product, service and company names mentioned in this document may be trademarks, registered trademarks, trade names of their respective holders.
# TABLE OF CONTENTS

1. Overview ........................................................................................................................................ 1  
   1.1 Configuration List................................................................................................................ 1  
   1.2 System Structure................................................................................................................. 2  
2. Software Installation ..................................................................................................................... 3  
3. SmartLCT Interface Introduction .................................................................................................. 4  
   3.1 Login..................................................................................................................................... 4  
   3.2 Menu Bar/Tool Bar ............................................................................................................... 5  
4. Language Settings ........................................................................................................................... 7  
5. Offline Operation ........................................................................................................................... 8  
   5.1 Creating Projects ................................................................................................................. 8  
      5.1.1 Cabinet Management ................................................................................................... 8  
      5.1.2 View Switching .......................................................................................................... 9  
   5.2 LED Display Configuration ................................................................................................ 10  
      5.2.1 Device List ................................................................................................................ 11  
      5.2.2 Cabinet Configuration ............................................................................................. 13  
      5.2.3 Screen Properties .....................................................................................................17  
      5.2.4 Loads of Ethernet Ports ...........................................................................................17  
   5.3 Hot Backup ........................................................................................................................ 18  
   5.4 Send.................................................................................................................................... 18  
6. Online Operation .......................................................................................................................... 20  
   6.1 Creating Projects ............................................................................................................... 20  
      6.1.1 Cabinet Management (See Cabinet Management in offline state) ...................... 21  
      6.1.2 View Switching (See View Switching in offline state) ........................................... 21  
   6.2 LED Display Configuration ................................................................................................. 21  
      6.2.1 Device List ................................................................................................................ 21  
      6.2.2 Cabinet Configuration (See Cabinet Configuration in Offline State) ................... 23  
      6.2.3 Screen Properties (See Screen Properties in Offline State) ................................. 23  
   6.3 Seam Brightness Adjustment ........................................................................................... 23  
      6.3.1 Area Splitting ........................................................................................................... 24  
      6.3.2 Cabinet Restoring ...................................................................................................... 25  
      6.3.3 Selection .................................................................................................................. 25  
      6.3.4 LED Details ............................................................................................................... 25  
      6.3.5 Display Window Modes .......................................................................................... 26  
      6.3.6 Deleting ................................................................................................................... 27  
   6.4 Restoring Seam Data......................................................................................................... 27
6.5 Hot Backup ................................................................. 28
6.6 Sending ................................................................. 28

7 V-Sender ................................................................................. 30
7.1 How to Access V-Sender? ........................................ 30
7.2 Menu Bar/Tool Bar ...................................................... 30
7.3 Adding Devices ............................................................ 31
7.4 Device Information ...................................................... 31
7.5 Device Attributes .......................................................... 33
  7.5.1 Attributes .............................................................. 33
  7.5.2 Input Signal Settings .............................................. 34
  7.5.3 Output Signal Settings .......................................... 34
  7.5.4 Color Settings ...................................................... 35
  7.5.5 System Settings .................................................... 35
  7.5.6 Audio Settings ...................................................... 36
7.6 Main Functions ............................................................. 36
  7.6.1 PIP ....................................................................... 36
  7.6.2 Self-Test .............................................................. 39
  7.6.3 Display Control ..................................................... 40
  7.6.4 Montage ............................................................... 41
  7.6.5 Template Settings ................................................. 42
1 Overview

SmartLCT is a new generation of LED display configuration software from NovaStar, in conjunction with LED display controllers for smart configuration of various complex LED displays, including building-block configuration, online/offline design, seam brightness adjustment, cabinet rotation, etc., to provide an easy access for users to operate LED displays and present you a perfect display.

Features

- Building-block configuration: Configure LED displays by adding cabinets via online or offline design and setting the position and physical connection of cabinets, which is easy to operate and flexible to configure.
- Seam brightness adjustment: Effectively solved the issue of brightness adjustment of seams among cabinets or modules. Seam brightness adjustment supports single and multiple selection to present you a perfect display.
- Canvas exporting: Users can export edited physical connections of cabinets and data related to devices in picture format.
- Hot backup: Backup Ethernet ports and devices to make sure the LED display operates normally when primary devices and Ethernet ports cannot work normally, which provides users protection and effectiveness for LED display configuration.
- Property settings of LED display controlling units including I/O source settings, color settings, PIP, montage, etc.

Operating system: OS X, Windows 7 or above.

1.1 Configuration List

<table>
<thead>
<tr>
<th>Name</th>
<th>Version/Model</th>
<th>Function</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>SmartLCT</td>
<td>V3.0</td>
<td>Operating Platform</td>
<td>Standard</td>
</tr>
<tr>
<td>LED Display Controllers</td>
<td>3D HD, NovaPro HD K4/K4S VX2/VX4/VX4S V700/V800/V900 MCTRL300/MCTRL500/MCTRLR5/MCTRL600/MCTRL660/MCTRL4K</td>
<td>Primary controllers of LED display and video processing units</td>
<td>Optional</td>
</tr>
</tbody>
</table>
1.2 **System Structure**

<table>
<thead>
<tr>
<th>Receiving Cards</th>
<th>Display driver modules of LED display</th>
<th>Optional</th>
</tr>
</thead>
</table>

![Diagram of system structure](image-url)
2 Software Installation

Just like the installation of other common software, install SmartLCT3.0 by following the setup wizard.

<table>
<thead>
<tr>
<th>In case of antivirus or firewall popups during installation, please permit them because serial driver may need to be installed during program installation.</th>
</tr>
</thead>
<tbody>
<tr>
<td>The installation program will update the serial driver on customers’ computer to the version of the driver in the installation package automatically if there is no serial driver or its version is too low.</td>
</tr>
</tbody>
</table>
3 SmartLCT Interface Introduction

3.1 Login

After SmartLCT is installed successfully, click on the icon to access the start page, as shown in the figure below.

Create new online or offline projects, or open existing projects, then access the page of LED display configuration, as shown in the figure below.
## 3.2 Menu Bar/Tool Bar

<table>
<thead>
<tr>
<th>Menu Bar/Tool Bar</th>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Undo (Ctrl + Z)</td>
<td>![Undo]</td>
<td>Back to last step</td>
</tr>
<tr>
<td>Redo (Ctrl + Y)</td>
<td>![Redo]</td>
<td>Cancel last step</td>
</tr>
<tr>
<td>Group</td>
<td></td>
<td>All the cabinets will be edited or moved together after grouping.</td>
</tr>
<tr>
<td>Ungroup</td>
<td></td>
<td>Recover the grouped cabinets to single cabinets.</td>
</tr>
<tr>
<td><strong>View</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom in</td>
<td>![Zoom In]</td>
<td>Zoom in the view of the cabinets on the screen.</td>
</tr>
<tr>
<td>Zoom out</td>
<td>![Zoom Out]</td>
<td>Zoom out the view of the cabinets on the screen.</td>
</tr>
<tr>
<td>1:1</td>
<td></td>
<td>Display the cabinets with a scale of 1:1.</td>
</tr>
<tr>
<td>Zoom to fit</td>
<td>![Zoom to Fit]</td>
<td>Adjust the cabinets to a viewable size on the screen.</td>
</tr>
<tr>
<td>Online status</td>
<td></td>
<td>Select this option to show the status of the receiving cards connected to the Ethernet ports of the device. (Green denotes online while gray offline.)</td>
</tr>
<tr>
<td>Cabinet info</td>
<td></td>
<td>Including “Sending card info”, “Port No.” and “Receiving card info”. The information of the option you selected will be shown on the cabinets.</td>
</tr>
<tr>
<td>Auto connect</td>
<td></td>
<td>Select this option and the added cabinets will be connected automatically.</td>
</tr>
<tr>
<td>Show grid</td>
<td></td>
<td>Select this option and the grid on screen area will be visible.</td>
</tr>
<tr>
<td>Snap</td>
<td></td>
<td>Including “Snap to grid” and “Snap to cabinet edge”. Select it, and when you moving a cabinet, the cabinet will snap to the border of its nearest grid or cabinet automatically.</td>
</tr>
<tr>
<td>View</td>
<td>![View]</td>
<td>Including “Front view” and “Back view” for changing users’ view while looking at cabinet connections.</td>
</tr>
</tbody>
</table>
## SmartLCT User’s Manual

### Operation (Online)

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reconnect device</td>
<td>Reconnect all the devices.</td>
</tr>
<tr>
<td>Refresh device</td>
<td>Refresh device status information</td>
</tr>
<tr>
<td>Send</td>
<td>Send screen configuration information to corresponding controllers.</td>
</tr>
<tr>
<td>Save to hardware</td>
<td>Save screen configuration information to hardware so as to avoid information loss.</td>
</tr>
<tr>
<td>Hot backup</td>
<td>Backup devices and Ethernet ports.</td>
</tr>
<tr>
<td>Seam brightness adjustment</td>
<td>Adjust brightness of the seams among cabinets.</td>
</tr>
<tr>
<td>Test patterns</td>
<td>Choose different screen test patterns.</td>
</tr>
</tbody>
</table>

### Tools

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculator</td>
<td>Open the calculator of Windows.</td>
</tr>
</tbody>
</table>

### Help

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>About</td>
<td>Check the information related to this software.</td>
</tr>
</tbody>
</table>

### Language

<table>
<thead>
<tr>
<th>Language</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/</td>
<td>Switch UI language between English and Chinese.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete lines</td>
<td>Delete the lines among cabinets.</td>
</tr>
</tbody>
</table>
4 Language Settings

SmartLCT supports two languages: English and Chinese. You can switch languages through following two ways.

- Click **Language** on the start page and an option box appears, then select the language you want.

- Access the page of LED display configuration. Click **Language** on the menu bar and a drop-down menu appears, then select the language you want.
5 Offline Operation

5.1 Creating Projects

Run the software. Create a new project of LED display configuration in offline state. Click Create offline design on the page of Function to access the page of Create a new project.

1) Customize the project name and select the save path of the project.
2) Select the device: Select the matched controller. Here we take MCTRL4K as an example.
3) Select the cabinet: Select LED display cabinet manufacturer and type.
4) Screen size: Set the number of columns and rows of cabinets.
5) Connection type: Choose the way to connect the cabinets.

5.1.1 Cabinet Management

① Select& Export: Export the information of selected cabinets to files
② Export all: Export all the cabinet information to files

③ Delete: Delete selected cabinets.
④ Add: Add new cabinets.
⑤ Edit: Edit selected cabinets.
5.1.2 View Switching

- The page of Create a new project includes two views: “Normal” and “Smart”.
- It only needs to name the project, choose the save path and select the cabinet in “Normal” view.
5.2 LED Display Configuration

As shown in the figure below, the page of LED display configuration appears after a new project is created.
5.2.1 Device List

Create new projects or click existing projects to access the page of LED display configuration.

Click on the selected device to expand the drop-down list of Ethernet ports. Use your mouse to drag the scrollbar to view all ports.

Add devices

Click Add devices at the bottom of the device list to add new devices.

- Click the device models you want to add in “Optional devices”. Double click on the field of “Number” column in “Optional devices” to edit the number of cascaded devices.
- Click **Add** button on the middle area after a device is selected to add the device to “Selected devices”. Click **OK** after the device is added.

**Device Properties**
Select a cabinet on editing area and its properties are shown on property area. Here we take MCTRL4K as an example.

![Device Properties](image)

“Properties” includes “Manufacturer”, “Type”, “Device”, “Port name”, “Connection”, “Mapping position”, “Position” and “Test patterns”.
“Connection”: 1-2-3 denotes sending card No. 1, port No. 2, receiving card No. 3.
“Mapping position”: The position of the added cabinet on the screen.
“Position”: The position of the selected cabinet on the screen.
“Test patterns”: Choose the corresponding test pattern of the selected cabinet.

**If devices with rotation function are connected, for example, MCTRLR5:**
Added “Rotation” function: Select a single cabinet and set its rotation angles, then is enables the rotation of a single cabinet. If many grouped cabinets are selected, set the rotation angle and all the selected cabinets will be rotated together.
5.2.2 Cabinet Configuration

Add cabinets

As shown in the figure below, click **Add** button on the tool bar to access the page of Manage cabinets. Then click on to access the page of Edit added cabinet. Edit cabinet information such as manufacturer and cabinet name on the page of Edit added cabinets. After the information is edited, click **Save** and a new cabinet is created.

Edit Cabinets

Click **Add** button on the tool bar to access the page of Manage cabinets. Select the cabinet to be edited and click **Edit** button to access the page of Edit added cabinet where cabinet information can be edited. Click **Save** after finishing editing, as shown in the figure above.

Cabinet Connections

As shown in the figure below, choose a cabinet connection type on the tool bar. There are two ways to connect cabinets.
I. Auto

**View > Auto connect**

Click **View** on the menu bar and select “Auto connect” on the drop-down menu that appears. Select the matched device and ports from the device list at the left side of the page. Then click **Cabinet** button, hold and drag it into editing area, and you can click on the editing area repeatedly to add more cabinets. Right click on your mouse to cancel adding cabinets, then connection lines among the added cabinets will appear automatically (or hold and drag the mouse on the editing area to add more cabinets continually and connection lines among the added cabinets appear automatically, then right click on your mouse to cancel adding cabinets.).

**Note:**
The connection order is based on the adding order. You can select all the cabinets and select a connection type on the tool bar to change the connection of the cabinets.
II. Manual

Click **View** on the menu bar and deselect “Auto connect” on the drop-down menu that appears. Select the matched device and ports from the device list at the left side of the page. Then click and hold **Cabinet** button and drag it into editing area, and you can click on the editing area repeatedly to add more cabinets. Select all the cabinets and choose a cabinet connection type from the tool bar, then cabinets on the editing area will be connected based on the connection type you choose.

**Note:**

After the cabinets on the editing area are connected manually, it is needed to choose and edit cabinet connection type again if new cabinets are added.
Add cabinets

Select cabinets

Select new connection type

Delete Lines
Select the cabinets among which the lines will be deleted, and click on Delete lines button to disconnect the cabinets.

5.2.3 Screen Properties

Click on the blank of the screen and Properties of the screen will be shown on the right side of the page. Properties include grid color, grid spacing, disable edit.

Grid color: Click on the icon on the right side to select and edit grid color.
Grid spacing: One grid spacing is 10 pixels (within 1~500).

5.2.4 Loads of Ethernet Ports

You can view the loads of each Ethernet port at the bottom of editing area: Blue denotes that the load is normal and the detailed information can be shown. Red denotes the load is exceeded.
5.3 **Hot Backup**

Click on **Hot backup** button on the right side of toolbar to access the page of hot backup.

Click the drop-down menu on the right side of Port name and select the port you want to back up on the page of Hot backup.

Click on **Add** button on the page of Hot backup to access the page of Add.

5.4 **Send**

Click on the tool bar and it will prompt you “Do you want to match device?”
Choose “Yes” and select matched online device on “Online devices”.

Choose “No” and do not send.
# 6 Online Operation

## 6.1 Creating Projects

Connect LED display controller to the PC used currently. Run the software. Refresh device list to show device model and screen size.

Create new projects of LED display configuration in online state. Click **Create online design** to access the page of Create a new project.

1. Customize the project name and select the save path of the project.
2. Select the cabinet: Select LED display cabinet manufacturer and type.
3) Screen size: Set the number of columns and rows of cabinets.
4) Connection type: Choose the way to connect the cabinets.

6.1.1 Cabinet Management (See Cabinet Management in offline state)
6.1.2 View Switching (See View Switching in offline state)

6.2 LED Display Configuration

Access the page of LED display configuration after new projects are created. Devices on the left are online, as shown in the figure below.

6.2.1 Device List

Create projects or click existing projects to access the page of LED display configuration. Device list is on the left side of the page.

Click the device to expand Ethernet port list and use the mouse to drag the scrollbar to view all the ports.

Device Properties
Select a cabinet from editing area and the properties of the cabinet are shown on property area. See details in Device List in offline state.
Adjust Color of LED Display
Move on to “Color” tab to adjust brightness and Gamma of LED display. It allows you to customize color temperature (R, G and B brightness). Select “Synchronize” to adjust R, G and B brightness synchronously.

Source Mapping
Move on to “Source mapping” tab to view mapping position of current device (the position of the first added cabinet on LED display) and resolution of the video source of current device.

Click “Advanced” to access advanced settings page of mapping of the selected device. Adjust mapping position to change cabinet position on the screen.
Click the drop-down box at the right side of “Background” and you can choose “Default”, “Grids” or “Pictures” as background. (The added background is applied on advanced settings
6.2.2 Cabinet Configuration (See Cabinet Configuration in Offline State)

6.2.3 Screen Properties (See Screen Properties in Offline State)

6.3 Seam Brightness Adjustment

It is required to complete the configuration (refers to adding cabinets and connect them) on the page of LED display configuration. Click Operation>Fast Adjust Seam Data>Seam Brightness Adjustment to access the page of Seam Brightness Adjustment. As shown in the figure below, here we take VX4S as an example.

The number of cabinets on the page of Seam Brightness Adjustment is the same as the number on the page of LED display configuration.
Buttons at the bottom right corner of the page include:

- **Send**: For sending seam brightness information to sending cards.
- **Save**: For saving current seam brightness information.

### 6.3.1 Area Splitting

Click the icon on tool bar and the page of Area Splitting appears. Set the number of rows and columns after a cabinet is split, then click OK to see the result.

**Note**: The number of rows and columns after a cabinet is split defaults to 5.
6.3.2 Cabinet Restoring
Click the icon on tool bar to restore the spilt cabinet to original state.

6.3.3 Selection
Selection includes “Select row and column”, “Column selection” and “Row selection”.
Click the icon on tool bar, then click and drag your mouse to select cabinets and all the
borderlines of the cabinets are selected, as shown in the figure(left) below.
Click the icon on tool bar, then click and drag your mouse to select cabinets and only
horizontal borderlines of the cabinets are selected, as shown in the figure(middle) below.
Click the icon on tool bar, then click and drag your mouse to select cabinets and only vertical
borderlines of the cabinets are selected, as shown in the figure(right) below.

6.3.4 LED Details
Click on the borders of any cabinets and LED details will appear on the right side of the screen.
Details of LEDs on the right border of Cabinet4 are shown as the figure below.

Select some of the LEDs, click and drag the slider on the right side of “Selected Area Parameters
Adjustment” to adjust the parameter (defaults to 1.000). The selected area will be shown on the
border of the cabinet.
Meanings of different colors:

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gray</td>
<td>There is no adjustable value if not selected.</td>
</tr>
<tr>
<td>Blue</td>
<td>There is no adjustable value if selected.</td>
</tr>
<tr>
<td>Light green</td>
<td>There are adjustable values if not selected.</td>
</tr>
<tr>
<td>Dark green</td>
<td>There are adjustable values if selected.</td>
</tr>
</tbody>
</table>

### 6.3.5 Display Window Modes

Click the button on tool bar to switch display window mode (free switch between normal mode and expanded mode).

**Show/Hide Display Number**

Click the button on tool bar to show cabinet numbers on display window. Click the button again to hide the numbers.

**Display Window Background**

Click the button on tool bar to choose the background color of display window.
6.3.6 Deleting

Click the button on tool bar to deselect the borderlines of all the cabinets.

Click the button on tool bar and a dialog box pops up to confirm “Has the set data been deleted completely?” Choose Yes to restore the interface to original state.

6.4 Restoring Seam Data

After completing the configuration (refers to adding cabinets and connect them) on the page of LED display configuration. Click Operation>Fast Adjust Seam Data> Restore Seam Data to access the page of Restore Seam Data, as shown in the figure below.
Click on the icon at the right side of “Seam Adjust File” to view and choose a path to save the file. After the file is loaded successfully, click **Restore** to restore the seam data which is adjusted before. Click **Undo** to cancel the operation to restore seam data.

### 6.5 Hot Backup

Click Hot backup button at the top right corner of the tool bar to access the page of Hot backup.

![Hot backup window](image)

Click Add button to access the page of adding backup.

![Add window](image)

### 6.6 Sending

Click the button on tool bar to send LED display configuration information to corresponding device.

If the loading capacity of Ethernet ports is exceeded, it will conform “It exceeds the loading capacity. Sure to continue?”
If the Ethernet ports can load normally, the information will be sent successfully.
7 V-Sender

Devices supported by V-Sender includes MCTRL300(MSD300), MCTRL660/600, MCTRL4K, VX4S, NovaPro HD, 3D HD. When different devices are added, the interface of V-Sender will change according to different functions of the devices. Here we take VX4S as an example.

7.1 How to Access V-Sender?

I. Click the button as show in the figure below behind Device list on the stare page of SmartLCT to access V-Sender.

II. As shown in the figure below, click the button on the page of LED display configuration to enter V-Sender.

7.2 Menu Bar/Tool Bar

<table>
<thead>
<tr>
<th>Menu Bar/Tool Bar</th>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device</td>
<td><img src="image" alt="Reconnect Device Icon" /></td>
<td>Connect the device again.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Refresh Icon" /></td>
<td>Refresh device data.</td>
</tr>
</tbody>
</table>

www.novastar.tech
### 7.3 Adding Devices

- Click **Device > Add Devices** on the menu bar.
- Click on **Add Device** at the bottom of device list.

Click **Add Device** and the page of Add Device appears, select the device you want to add and click **OK**, then the new device is added to the page.

![Add Device Page](image)

### 7.4 Device Information

- Enter V-Sender and allow you to view device model, Ethernet port and the number of cascaded devices in device list.
After the device is added successfully, the picture and function introduction of the device will be displayed on the Overview page of the editing area, as shown in the figure below.

The “Information” bar under the editing area includes “Supported Screen Size”, “Ethernet Port Status.”

- Ethernet port status: “backed up & not connected”, “backed up & connected”, “not backed up & not connected”, “not backed up & connected”, “Backup takes effect.”

- denotes that the port is primary port and connected to receiving cards.
- denotes that the port is primary port and not connected to receiving cards.
- denotes that the port is backup port and connected to receiving cards.
denotes that the port is backup port and not connected to receiving cards.

denotes that the backup port is being used for signal output now. (It indicates that cable of this output channel is disconnected.)

**Note:**
The items of device information displayed are different while adding different devices, for example, if a Novar HD unit is added, the information includes “Temperature” and “Voltage”. The figure below shows the device information of NovaPro HD.

### 7.5 Device Attributes

#### 7.5.1 Attributes

You can see the attributes of the device on the right side of the page (here taking VX4S for example). It allows you to view device name, port name, ID and firmware version.
7.5.2 Input Signal Settings

Move on to “Input” tab and users can set Source Type and Data Bits.

- Source types: DVI, DP and HDMI.
- Input source data bits are based on source types. Data bits of different source types are different. Data bits of source types including DVI, DP and HDMI are 8.
- You can use the preset values as “Resolution” and “Refresh Rate” in EDID or customize, as shown in the figure below.

![Input Signal Settings Diagram]

7.5.3 Output Signal Settings

Montage

When pixels of the LED display exceeds the loading capacity, montage needs to be enabled. The total pixels of all cascaded devices should be the same as the pixels of the LED display.

Montage: “Equal Division” and “Non-Equal Division”. See detailed introduction in the chapter Montage.

Note:

When a device is used for montage, “Disable Zoom” and “Custom Zoom” are unavailable and only “Auto Fit to Screen” is available.

Main Screen

Enable or disable main screen and set the zoom mode of main screen.

Zoom modes include “Disable Zoom”, “Custom Zoom” and “Auto Fit to Screen”. See details in the chapter PIP.

Minor Screen

Enable or disable minor screen and set the size and start position of minor screen as well as the...
size of position of the picture captured. The picture captured will be displayed on the LED display.

**Video Source Synchronization**

Keep video source input and output of the device in sync.

**Note**: Video Source Synchronization is not available when montage is enabled.

### 7.5.4 Color Settings

You can control the color of LED display by adjusting the parameters of “Contrast”, “Saturation”, “Hue” and “Sharpness”. Click and the sliders of corresponding parameters to adjust the values. Click **Apply** to save your settings.

![Color Settings](image)

### 7.5.5 System Settings

“LCD Lock”: Lock the LCD of the connected device. It cannot be operated after its LCD is locked.

“Smart Gray Scale”: Control LED display.

“Deinterlance”: Convert interlaced video signal to progressive signal.

“Genlock”: Synchronize read-only parameters.

“VGA Auto Processing”: Adjust the sampling parameters of VGA input signal automatically and make the pictures distinct and complete.

“ADC Auto Calibration”: It may cause color cast or dim pictures without ADC calibration.
7.5.6 Audio Settings

- Set whether to output the audio signal;
- There are two audio types including "HDMI Audio" and "External Audio";
- Adjust the volume by clicking and dragging the slider at the right side of Volume.

7.6 Main Functions

7.6.1 PIP

Switch to PIP in the editing area to enter the PIP setting page. Click different icons in the toolbar to adjust the layout status of the main screen and the minor screen, as shown in the following figure.

**Note:**
Move the mouse to the editing area, and click and drag the mouse to change the size of both the main screen and the minor screen.
<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel</td>
<td>🔄</td>
<td>Cancel the last operation.</td>
</tr>
<tr>
<td>Revert</td>
<td>🔄</td>
<td>Revert the last operation.</td>
</tr>
<tr>
<td>Zoom in</td>
<td>🔍</td>
<td>Zoom in the screen.</td>
</tr>
<tr>
<td>Zoom out</td>
<td>🔍</td>
<td>Zoom out the screen.</td>
</tr>
<tr>
<td>Main and Minor Screens</td>
<td>🔄</td>
<td>Switch between the main screen and the minor</td>
</tr>
<tr>
<td>Screens Switching</td>
<td></td>
<td>screen.</td>
</tr>
<tr>
<td>Horizontal Layout</td>
<td>📀</td>
<td>As shown in the picture</td>
</tr>
<tr>
<td>Vertical Layout</td>
<td>📀</td>
<td>As shown in the picture</td>
</tr>
</tbody>
</table>
In the Middle | As shown in the picture
---|---
Upper Left Layout | As shown in the picture
Lower Left Layout | As shown in the picture
Upper Right Layout | As shown in the picture
Lower Right Layout | As shown in the picture

**Main Screen Settings**

Set the main screen’s scaling status including “**Disable Zoom**”, “**Custom Zoom**”, and “**Auto Fit to Screen**”.

“**Disable Zoom**”: indicates to output images with the original proportion of the input images, only the image offset position can be adjusted.

“**Custom Zoom**”: sets the starting position of the cut image which will be displayed on the screen; “**Size**”: indicates the size of the current main screen displayed in the editing area; “**Position**”: indicates the starting position of the main screen displayed in the editing area.
“Auto Fit to Screen”: Input contents are completely scaled to the screen body size, automatically fitting the screen size. This mode is suitable for full-screen display of the display contents.

![Main Screen Settings](image)

After setting, click **Apply** to send the current configuration information to the signal source.

**Minor Screen Settings**

Tick “Cut” to edit the minor screen’s size and starting position, and the cut image will be displayed on the screen.

![Minor Screen Settings](image)

After setting, click **Apply** to send the current configuration information to the signal source.

### 7.6.2 Self-Test

Choose **Settings**, **Self-Test** to enter the self-test page.

**Test Type** includes “Color”, “Gradient”, “Grid”, and “Positioning”.

**Test Pattern**: There are various image types for different test types.

Customize test parameters including “Brightness”, “Spacing”, and “Speed” to make the image have different test results.
After the test, click **Normal Display** at the bottom of the page to restore the screen to the factory settings.

### 7.6.3 Display Control

Switch to **Control** page at the bottom of the editing area. Freely choose the signal source of both the main screen, the minor screen, and the screen status. The screen status includes **“Black Out”, “Freeze”,** and **“Normal”.**

- **“Black Out”:** does not display.
- **“Freeze”:** freezes the current displayed contents.
- **“Normal”:** normally displays the contents coming from the input source.

Following figure is the signal source conflict list (VX4S):

<table>
<thead>
<tr>
<th>Input Source of the Main Channel</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDMI</td>
</tr>
</tbody>
</table>

www.novastar.tech
7.6.4 Montage

Click **Output, Montage** in the right attribute area of V-Sender page to enter the montage setting page.

Montage function is required when the screen pixel numbers exceed the loading capacity of a single device. Sum of all the cascading device loading areas is the total number of the screen pixel (taking VX4S as an example).

- **“Non-Equal Division”**: Each VX4S loads different areas. Total number of the screen, loading area of each VX4S, and starting position of the loading area are required to be set;
- **“Equal Division”**: Loading area of each VX4S is the same, and just set the total number of the screen, row and column number, and the loading area of this VX4S.

After parameter setting, click **Apply** to send the parameter-set to hardware.
### 7.6.5 Template Settings

Switch to **Template** page at the bottom of the editing area. Save the current configured parameters as templates, of which default number is 10, to be directly loaded next time.

- Click icon ![icon](image) to save the current configured parameters as templates with the to be selected template optional.

- Click icon ![icon](image) to delete the selected template.